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Enter the World of Spreadsheets
A spreadsheet is an electronic piece of paper divided into rows and column209s. We can use a 
spreadsheet to tabulate grades, budgets, bank loans, inventory totals, or calculate experiments in 
science. 

Rows & columns
A spreadsheet consists of rows and columns. Just like the pillars that hold up a building, columns 
are vertical. And just like radishes in a garden, the rows are horizontal. The intersection of each 
row and column is called a Cell.

The rows of a spreadsheet are labeled on the left with numbers 1,2,3 and so on, going down 
usually for at least 1000 rows. The columns are labeled on the top with letters from A to Z. 
Although beginners think there are only 26 columns, the notation of AA, AB, AC through AZ 
allows for another 26 columns. Although some spreadsheets have just 52 columns, most have 
several hundred using BA through BZ, CA through CZ and so on. 

Labels & values
Each entry you put into a cell can be a label or a value. Labels are generally words or phrases, 
used for column headings, row headings or special comments - labels are generally considered 
“cosmetic.” In contrast, values include numbers, functions and formulas. Try typing a word or a 
number into a cell and watch how it automatically jumps to the left or right of that cell. Words - 
i.e. labels - are automatically left justified while numbers - i.e. Values - are automatically right 
justified. 
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System formulas
Each spreadsheet software package comes with a number of built-in formulas such as Sum and 
Average. These are called System formulas. Each formula begins with the = symbol and is 
followed by the appropriate code and the specified cells in parentheses. Although we present 
below a summary of examples, note that many spreadsheet users get by using just 1 or 2 of these 
formulas. Do not feel overwhelmed by the variety of formulas. Like learning to program in Logo 
and learning to speak English, we have a language here with no threshold and no ceiling! Start 
with just one or two, please, and learn to use those formulas skillfully!
 
=AVERAGE(B1:B12)  Averages the 12 cells
=SUM(C5:C9) Finds the sum of the numbers in these 5 cells
=SQRT(D7) Finds the square root of the number in this cell
=MIN(B3:B100) Finds the minimum value in these 98 cells
=MAX(B3:B20) Finds the maximum value in these 18 cells
=COUNT(A1:A10) Counts how many non-blank entries are here 
=IF(D3>90,5,0) Checks the value of D3 to see if it is bigger than 90. If so, put a 

5 into the current cell. If not, put in a 0. Very useful for 
converting data. 

=LOOKUP(D3,B20:B30) Looks up the value of D3 amongst the “LOOKUP TABLE” that 
has B20-B30 for a left edge; returns with the corresponding 
value from this table. On some SS programs, you must provide 
both ranges e.g. =LOOKUP(D3,B20:B30,C20:C30).

Creating formulas
Additionally, you create your own formulas by starting the entry with a = sign. Your own 
formula will look algebraic, containing numbers and variables. The variables will not be X, Y 
and Z but instead will be other cells on the spreadsheet, such as A3, B4 or C6. You will use 
parentheses around certain expressions when the order of operations is significant, just as we 
learn in ninth grade algebra. 

The four operations symbols are 
 + ADD - SUBTRACT * MULTIPLY / DIVIDE
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Here are some examples: 
=C5-B4 Computes difference of two cells
=B3+(B3*.12) Computes 12 percent increase from B3
=B3*1.12  Another way to calculate 12 % increase
=(B3*12/100) And still another way
=(C3*.1)+(D3*.5)+(E3*.4) Computes weighted average of C3,D3 & E3
=(C3+(D3*5)+(E3*4))/10 Computer weighted average another way
=B3*1.07 Finding 7% population increase
=C3-B3 Finding $ salary increase from B3 to C3
=100*(C3-B3)/B3 Finding % salary increase from B3 to C3
=B3+1 Adds 1 to B3; very useful for generating 50 to 100 integers or 

years quickly 

Using a spreadsheet, you can lay out a small or huge chart of words and numbers. Columns can 
be made the desired width. You can insert or delete rows or columns. Each spreadsheet package 
comes with many built-in formulas for finding SUMS, AVERAGES and other computations; you 
can enter your own custom formulas as well to accomplish almost any specific task. 

In summary, you might say that a spreadsheet is to a calculator what a word processor is to a 
typewriter. To quote one 4 year old named Sam who spotted an old Olivetti typewriter in the 
basement one day, “Hey, Daddy, look, I just found one of those old computers.”

Basic Skills & Concepts
After Rows and Columns, the next spreadsheet words to use are Entry and Range. An Entry is 
sometimes used instead of the word Cell to refer to one location. Frequently, we refer to a Cell or 
an Entry as we might refer to a location on a bingo board: A2 or B3 or D44. We always refer to it 
by naming it with the letter first. A Range is a rectangular block of cells on the spreadsheet. In 
the example, the Range consists of 4 rows down and 2 columns across. We refer to this range as 
B2:C6. Note that a Range can be just 1 column across or 1 row down.

Column width
With most spreadsheet packages, you can customize your spreadsheet to make each column a 
desired width. Or you can set all the columns in your sheet to a specified number. This gives you 
flexibility in designing your own customized ledger paper.
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You change the size of a column by going to the heading section where the columns are labeled 
with A, B, C. Move the mouse to the VERTICAL divider between 2 column headings; when it 
becomes a double headed arrow, click and drag. The column will become smaller or wider as the 
mouse moves. You can also change the row height using the same technique by placing the 
cursor on the line that separates the rows and then clicking and dragging. 

Caution: When the symbols #### appear in a column then that column is too narrow for that 
particular entry and needs to be widened in order to show the numbers. You can experiment with 
this by narrowing a column with large numbers and watching the ### signs appear. Then fix the 
column by widening it and the data will reappear.

Getting Started Step by Step
STEP 1...Double click on Excel to start working on a new worksheet (Excel's term for a 
spreadsheet.) 

STEP 2...Make a cell active: move the cursor into cell A1; then click the cursor and the cell will 
become outlined. The rectangle in the top left hand corner indicates the active cell. In the graphic 
above, the active cell is B2. Data is not entered directly into the active cell, but you type in the 
top rectangle above cells A1, B1, etc. When you press Return, Enter or Tab, the data is entered 
into the active cell.

STEP 3...Enter your column label headings on the top row in cells A1, B1, C1, D1 and so on. 
Each time you enter in a word, push Tab to complete your entry and move your cursor to the next 
cell. Label your rows in column A using cells A2, A3, A4, and so on. Try to keep your entries 
fairly short for now so that information won’t “spill” over to the next cell on the right. Avoid 
changing the column widths for now. If you make a mistake, move to that cell and retype your 
word or number in. To clear a cell, use mouse or arrow keys to move to that cell, then push 
Delete and Return or Enter.

STEP 4...Type in the actual data onto the ledger paper. Notice how words are automatically 
aligned left and numbers are aligned right. 

STEP 5...In order to appreciate the power of the Spreadsheet tool, define one cell to be the sum 
or average of the ones above it or to the left of it. Move the marker to the cell where you want 
the SUM or AVERAGE formula to appear. Then type in a formula such as =SUM(B2:F2) or 
=AVERAGE(B2:F2).
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STEP 7...Once you’ve entered several formulas in different locations, edit some of the numbers 
in the “central area” of the spreadsheet. As you type in the new numbers and push Return or 
Enter, you’ll see the results in your formula cells change. In other words, formulas like finding 
the Average or the Sum of a range of cells are not set in stone; they reflect changes in data. So if 
a student complains about a grade and you decide to give a few extra points to that test score, 
you at least do not have to revise your formula because the new average will be calculated 
automatically. Congratulations! You’ve entered the world of spreadsheets. 

STEP 8...Make sure you SAVE your work.

A to Z Excel Spreadsheets
One of the great things about spreadsheets is that most basic skills are similar regardless of the 
“brand” spreadsheet you are using. In the following A to Z, Excel differences will be noted.

How To Explanation
Absolute Reference When filling down a formula, the default is relative 

reference. To make a value absolute, type a $ before 
the reference in the formula (=B2/$E$5).

Activate (Select) a cell Click cursor into the cell; it will be outlined to 
show that it is active and its cell address will appear 
in the upper left-hand corner of the spreadsheet.

Activate (Select) a column Click the cursor into the column heading (titled A, 
B, C, etc.) not into the cell A1, B1, C1 etc.

Activate (Select) a row Click the cursor into the row heading (titled 1, 2, 3, 
etc.) not into the cell A1, B1, C1 etc.

Activate (Select) several columns Click-hold the cursor into the column heading of 
the first column you want to select (titled A, B, C, 
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etc. not into the cell A1, B1, C1 etc.) and then keep 
the mouse button down and drag the cursor through 
the headings of the other cells you want to select.

Activate (Select) a range of cells Click-hold the cursor into the cell that you want to 
be the beginning of the range and then keep the 
mouse button down and drag the cursor through the 
other cells you want to select.

 
 You can select noncontiguous ranges by selecting 

the first range, then press the Command key or Ctrl 
on the PC and drag the mouse over the next group 
of cells.

Activate (Select) all cells Click the far left hand corner box next to Header A.

Activate all cells containing data Option-click the far left hand corner box next to 
Header A.

Add data Click cursor into the cell and type data in the data 
entry bar at the top of the spreadsheet; you do not 
have to click the cursor into the data entry area.

Center Data across columns To center data across several columns, select the 
cells you want to center the data across with the 
first cell containing the data to be centered. Go to 
the Format Menu, then Cells, then click on the 
Alignment Tab, then click the box next to Merge 
Cells. Next choose the Horizontal and Vertical 
Alignment and then OK.

 
Center Data on a page To print the spreadsheet so it is centered on the 

page, go to File Menu, then Page Setup. In the 
dialog box, click the Margins Tab. In the Center on 
the Page area, click either Horizontally or Vertically  
and then click OK.

Change the attributes of fonts Excel allows formatting from the toolbar. Or select 
the cell, go to the Format Menu on the Mac, then 
click Cells, then click the appropriate Formatting 
tab.

Change format of number or date Excel allows formatting from the toolbar. Or select 
the cell, go to the Format Menu, then click Cells, 
then click the appropriate Formatting tab.

Chapter 13 • Spreadsheets • page 214



Change number of decimals Select the cell, go to the Format Menu, then click 
Cells, then click the appropriate Formatting tab.

 Change width of column Move cursor to dividing line in the column header 
and when it turns into a double headed arrow, click 
and drag either left or right. Or select the column or 
columns to widen or narrow and go to the format 
menu and choose column width (or row height) and 
enter a new number. Remember that 72 pt equals 1"

Clear(Cut) data from a cell Activate the cell and choose Cut or Clear from the 
Edit menu. 

Concatenate cells To join together the data from two cells into one 
new cell, create a formula beginning with = and 
then enter the first cell, followed by & and then " " 
to indicate a space and then &second cell. For 
instance to join the First Names in Column A with 
the Second Names in Column B, enter into Column 
C the following formula: =A2& " " &B2

 
Copy data to another cell Activate the cell that contains the data or formula to 

be copied and choose Copy from the Edit menu. 
Then move cursor to the new cell, click and then 
choose Paste from the Edit menu

Copy data into a range of cells Enter the data or formula into a cell. Then click on 
that cell and place the mouse over the bottom right 
corner of the cell. The icon will change into a Plus 
sign. Then drag the mouse over the cells you want 
to receive a copy of the data and then release the 
mouse.

Copy Data in a series Enter the first of a series. Excel completes a text 
series based on the text in one cell and completes a 
number series based on the numbers in the first two 
cells. After entering the data, select the first cell and 
place the mouse over the bottom right corner of the 
cell. The icon will change into a Plus sign. Then 
drag the mouse over the cells you want to receive 
the series of the data and then release the mouse. Or 
enter the first of the series, press Enter, then Hold 
down Ctrl as you drag the fill handle - in the 
bottom right corner of the first cell- and drag down 
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to the last cell. In the pop up menu, choose the type 
of series.

Copy Formatting Select the cell which contains the formatting, then 
click the format painter icon on the toolbar (it looks 
like a paint brush). Then select the cells you want 
to display that formatting.

Delete a row or column Activate the row or column and then go to the Edit 
menu and choose Delete.

Display a formula Select Tools Menu, click Preferences. Click View 
Tab. Choose Window Options --> Formulas.

Edit existing data Activate the cell and simply type the new data into 
the data entry bar; you do not have to click the 
cursor into the data entry area. Then press return or 
the check mark next to the data entry area.

Enter a formula Excel- The only difference in Excel is that a range 
is separated by a colon as in A2:A11 so the formula 
would look like =SUM(A2:A11). Always be sure to 
press Return or Enter or Tab upon completion.

Graph data (Make Chart) Select the range of cells to be graphed and click the 
Chart Wizard button on the Toolbar. Click a chart 
type and subtype and then click Next. Select the 
options for your layout and then finally click 
Finish. You can place the graph as a separate file if 
you choose As New Sheet or you can insert it into 
your existing spreadsheet, by choosing Object In.

Graph additional data After you have created your chart, you can always 
add a new series of numbers to it. First select the 
range of cells that contains the data, and then drag 
the range into the existing chart. 

Insert (Add) a row or column First select either a row or column, then go to the 
Insert Menu and choose Rows or Columns.

Move data Select the cells and then drag and drop to a new 
location. 
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Page Break Select row or column, then Insert Menu, then Page 
Break.

Print selected data Select the range of cells to be printed and then 
choose File, then Print. In the Print dialog box, 
choose Selection in the Print What 
area.  

Print without headings To customize your printout by choosing to hide 
column and row headings and the gridline, go to the 
File Menu, choose Page Setup. In the dialog box, 
choose the Sheet Tab. There you can click on or off 
each one of these options. 

Quickly apply a design Select the cells and then go to the Format Menu and 
choose AutoFormat. Select one of the preformatted 
designs. Click OK.

 
Sort (Alphabetize) cells Select the cells, column or range of cells to be 

sorted and then choose Sort from the Calculate 
menu; Remember to select an entire range if you 
want all the cells to be rearranged as one unit. 
Choose the sort order, i.e. the column that is to be 
the basis of the sorting.

Wrap text within a cell Select the cell(s) and then Go to Format Menu, 
Alignment and then Wrap; you will probably have 
to adjust the row height to show all the text.

Common Mistakes and Warnings
• Reserve column A for names or titles and row 1 for headings.

• Don’t double space your rows. Each row should be 1 set of information. Do not use 2 rows of 
information to store info on 1 person, place or thing.

• Don’t try to make headings too lengthy or descriptive; keep them short!

• Push Return after completing each cell entry to lock in the data.

• To replace a cell entry, just move to that location and retype it.
If you start spilling over from 1 column to the next, you might wish to widen the column before 
going any further. Even better, avoid long entries.

• Don’t forget to start system formulas with = sign 

• Avoid “mixed” entries such as 87 TOTAL or 78R until you get more sophisticated. Make each 
entry either a number or a word.

• Before you get too involved, learn how to edit an existing cell 
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• Each column should contain a different type of information. For example, use different 
columns for first name, last name, city, state and zip code. Avoid putting a mixture of 
information into one column.

• On some spreadsheets, if you go one row up from the top row, you end up at the bottom row of 
the spreadsheet, perhaps row 9999. Watch out for this; when this happens, move down one row 
from this location with down arrow and you will get back to the top of the spreadsheet. 

• On some spreadsheets, if you go one column to the left of column 1, you end up on the far right 
column of the spreadsheet, perhaps column IV. Watch out for this; when this happens, move right 
one column from this location with right arrow and you will get back to the left of the 
spreadsheet. 

• Beware! It is possible to sort a spreadsheet and get it irrevocably messed up as a result. Best 
strategy is to first Save. In case it doesn’t work out, you’ll be able to get the “before” version 
back. The common mistakes in sorting involve sorting the headings along with the data, sorting 
only certain columns and consequently “dismembering” your data, and altering formulas.

Tips and Tricks for Intermediate Users
• Although humans read from left to right, computers do not. Therefore it is more sensible to 
have a Current average located in a column on the left side, even though the data might reside in 
columns 3 to 20. In other words, the cell in column 2 might be defined to be the student’s 
average, using =AVERAGE(B3..B20) or =AVERAGE(B3:B20).

• Formulas can be set up before you enter the data; they will work fine even when only a few 
items of data are entered; as you enter more columns, the average will be continually updated.

• You can avoid some frustration by leaving a blank line or dotted line above the data and below 
the data. Then make your formulas be tabulated from dotted line to dotted line. This solves some 
quirks that would otherwise arise when sorting data or inserting rows.

• Inserting a blank column and making it very narrow (i.e. 1 or 2 characters wide) can serve as a 
visual separator, especially when placed between a column of numbers to the left and a column 
of labels on the right, which would otherwise be touching.

• Usually, it is best to right justify the labels at the top of each column in order so they 
correspond to the right justified numbers below.

• For generating consecutive integers, there is a very straightforward trick. Type the number 1 
into a cell such as A1. Then put the formula =A1+1 or +A1+1 into cell A2 and copy it down for 
50-100 cells. 

• The same trick is used for generating 20 year projections. Type the year 1989 into a cell such as 
C1. Then in cell D1 put the formula =C1+1 or +C1+1 and copy it to the right for 19 cells.

More Sophisticated Concepts and Features
Although the skill of Copying cells is relatively straightforward, the underlying concept of 
absolute vs. relative reference requires more elaboration. When you wish to Copy a word such as 
Totals from 1 cell to perhaps 5 other cells, there is no reference to any cells and therefore no 
confusion. But when you wish to Copy a formula such as =SUM(C2:C10) at the bottom of 1 
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column to be at the bottom of 5 other columns, there is some ambiguity. Do you wish the next 
column to also be C2:C10 or do you want it adjusted to be D2:.D10? In most cases, we want the 
second choice and that is why beginners almost always want to choose Relative Reference. This 
means that formula reference is relative to position and when the copy occurs, you are asking the 
computer to adjust the formulas Relative to your position. Once the COPY is done, each of the 
other 5 columns will have formulas with D2:D10, E2:E10, F2:F10, G2:G10 and H2:H10. 

To contemplate an example where Relative is not appropriate, consider a spreadsheet where we 
have projected the population of 5 countries over a 20 year span. We want the projection to be 
flexible so we can alter it from 5% to 6% to 7% and see the consequences. We define one cell, 
let’s say A2, to be the desired percent increase and want all the 100 (5x20) cells to be based on 
A2. When we do the Copy feature and want a formula such as =B5*A2 to be copied, we don’t 
want the A2 altered. We want the A2 to be held constant for all 100 cells. We designate A2 to be 
Absolute not Relative. 

We use a $ sign in front of the A and 2 to designate absolute reference. So the original formula 
would not be = B5*A2 but would probably be = B5*$A$2
instead. Then, when you copy this formula, the A2 variable will be held constant in all the other 
99 entries. And yes, this does look strange, but after using it, we get more comfortable. Each $ 
sign is designating the next symbol to be held constant. Consequently, advanced users know that 
 $A2 means “hold the A constant, but adjust the row if appropriate”
 A$2 means “hold the 2 constant, but adjust the column if appropriate”
and of course $A$2 in our example means to hold both row and column constant. Remember that 
these references apply only when you are copying or filling down/right.

Showing formulas: This refers to the user’s choice of seeing the data or seeing the formulas. 
Sometimes we want to see the entire spreadsheet with just the formulas so we can look for errors 
or verify our work. Subsequently, we want to flip the spreadsheet back to normal to see the data. 
In Excel, select the Tools Menu and then click Preferences. Click the View Tab. Under Window 
Options, choose Formulas.

Calculation: This refers to the ways that the spreadsheet recalculates the data, i.e. cells row-by-
row or column-by column? Believe it or not, for some spreadsheets, it makes a difference. More 
importantly, when a spreadsheet gets large, it is highly desirable to turn Calculation on to 
Manual, so that data entry does not slow down. The only disadvantage is that the calculations 
will be updated on the spreadsheet only via special request, not after each cell entry.

Windows: This concept refers to being allowed to view two parts of your spreadsheet at the same 
time, even though they are far apart from each other on the big spreadsheet. You can choose to 
have either horizontal or vertical windows. You move the thick black line at the top or far left of 
each elevator shaft to divide your big window into 2-4 smaller windows.

To the word processor: Being able to move your chart from a spreadsheet into a word processing 
document can allow for sophisticated projects. You just select the cells you want to move, choose 
Copy under the Edit menu and then proceed to your word processor document where you will 
Paste in the data from the clipboard.
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More advanced formulas: If and And
The IF function is very useful for doing an analysis on data and getting instant tallies on answers 
to certain questions. For example, imagine a spreadsheet of 1000 colleges, enrollments and 
faculty. Using an extra column, we construct a formula such as = B4/C4 or +B4/C4 to compute 
the ratio of B4 to C4; we then copy or fill down for the entire batch of 1000 colleges. Now, if 
you want to find out how many colleges have student/faculty ratios between any 2 specified 
numbers, you would use the IF function, for example in cell E4, you would type in a formula that 
says “IF the value of D4 is between B1 and B2, then enter a 1, otherwise enter a 0”. Consider the 
formula you see in the illustration below at location E4:

=IF(AND(D4>$B$1,D4<$B$2),1,0)
The AND part says “IF these 2 phrases are true,” i.e. If D4 is bigger than B1 AND if D4 is 
smaller than B2. Notice the syntax of AND(phrase1,phrase2). By putting this cell into E4 and 
then filling it down for 1000 cells, we get 1’s or 0’s in each location of column E, where 1 stands 
for TRUE and 0 stands for FALSE. The reason for the $B$1 and $B$2 has to do with absolute 
reference.
 

Curriculum Ideas for Spreadsheet Projects
STATISTICS Compute statistics on the color breakdown of M&M’s; each row contains 1 pack 

once opened; each column contains #RED, #GREEN, etc. Use formulas to get 
totals and percents on the far right. Use formulas at bottom or top to compute 
MAX, MIN, AVERAGE. For example, we might place into B2 the formula 
=SUM(C2:L2) if we want to use C through L for each color type and B for the 
total # of M&M’s in each package. 

MATH  Explore fractions and their decimal equivalents, looking for patterns. For 
example, column 1 might contain the numbers from 1 to 40. Column 2 might be 
column 1 divided by a certain common denominator, let’s say 41, using a formula 
in cell B2 such as +A2/41 or =A2/41. By copying the formula, you have an easy 
means of studying the decimal patterns and trying to conjecture why or why not 
certain patterns of decimals repeat.

MATH  Design and investigate Pascal’s Triangle on a spreadsheet. This is remarkably 
easy to do, placing a formula in B2 that would add up the 2 numbers above it, e.g. 
=A1+B1 or +A1+B1; copy or fill this formula down and to the right to get the 
whole chart. Now you can look for interesting patterns, such as which numbers 
are odd or even, which are multiples of a designated number, etc.

MATH  Investigate number patterns such as 1+3+5+7+... and see what the first n terms 
add up to. To generate the odd numbers in column A, we put 1 into A1 and the 
formula =A1+2 or +A1=2 into A2; we then copy or fill A2 down for 50 or 100 
cells. Use a formula with absolute reference such as =SUM($A$1:A2) placed in 
B2 to generate the sum of cells A1 to A2.
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MATH  Conduct probability experiments by making each row be the flip of a coin or roll 
of a die. Then tally the outcomes at the top or bottom of the screen. For example, 
the formula =Int(2*Rand()) will make the computer simulate the random flip of a 
coin; if we place this formula into C1 and fill it down for 100 cells, we get 100 
coin flips where 1 stands for HEADS and 0 stands for TAILS. Now putting into 
A1 the formula =SUM(C1:C100) we get an instant tally of NUMBER OF 
HEADS each time we choose CALCULATE and repeat the experiment. 

  
MATH  Create a spreadsheet to make charts of x-values and their y = f(x) functional 

equivalents, e.g. column B might have the integers from 1 to 20 with C1 defined 
to be =(2*B1*B1)-(3*B1)+4 or +(2*B1*B1)-(3*B1)+4 to show the change in the 
function y = 2x2 -3x + 4. Once C1 is defined, copy or fill it down for 20 cells.

SCIENCE  Keep track of the periodic table on a spreadsheet and look for relationships 
between atomic number, atomic weight and types of element. For example, if we 
put atomic numbers in column B and atomic weights in column C, then we can 
make column D equal the ratio by entering into D4 the formula =C4/B4 or +C4/
B4 and then copying or filling down.

SCIENCE  Maintain a spreadsheet of daily temperature, rainfall, etc. over the course of a 
school year, building in formulas for MAX, MIN, AVERAGE. Look for patterns, 
generalizations and predictions. For example, if column F contained temperatures, 
we could compute the disparity between high temperature and low temperature by 
using the formula =MAX(F1..F365)-MIN(F1..F365) or @MAX(F1:F365)-@MIN
(F1:F365).

SCIENCE  As students make their measurements and complete a lab experiment in class, 
they walk over to the corner of the classroom and enter their data into 1 row of a 
pre-designed spreadsheet. Each column is set up for a different measurement to be 
made. If a ratio between 2 columns is to be made, for example columns J and K, 
then a formula such as +J3/K3 or =J3/K3 can be prewired into column L. At the 
top of the spreadsheet can be several summary rows for MIN, MAX and 
AVERAGE of the samples below. For example, at the top of column L, we might 
have =AVERAGE(L2:L50). Depending on the spreadsheet, you can even have a 
row at the top for standard deviation of the data entered in the column below. The 
formula =COUNT(A2:A50) can be used to keep a running tally of how many 
students have entered data so far.

HISTORY  Develop a spreadsheet that shows immigration numbers from various foreign 
countries over each 10 year span of US History. Build formulas for percents from 
each country as well as for total # of immigrants in relationship to US population. 
For example, if column I was total number of immigrants and column B was total 
US population in that year, we could compute percentage of immigration by 
typing into J1 the formula =(I1*100)/B1 and then copying or filling down.
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GEOGRAPHY Develop a spreadsheet that lists cities and rates each one according to various 
characteristics. Then using a SUM formula, you can tally results in different 
columns to find the most livable city, most expensive city, or other overall 
characteristic. Using the SORT feature, you can then rank the cities accordingly. 
For example, if columns D,G,J and M had characteristics that were to be used to 
determine “most livable city,” we would put into a cell such as N2 the formula 
+D2+G2+J2+M2 or +D2+G2+J2+M2 if we want to tally those columns. Or, if we 
want to weight those columns, we might use +(D2*2)+(G2*3)+J2+(M2*2) or =
(D2*2)+(G2*3)+J2+(M2*2) depending on the assigned weights of each 
characteristic. 

HISTORY  Develop a spreadsheet that works as a time line. Each row of the spreadsheet 
contains 1 historical event, using 1 column for year, 1 column for month, 1 
column for day, 1 column for event and perhaps 1 column as a code for type of 
event. As students encounter events, they enter them onto the spreadsheet. Once 
lots of data has been entered, sorting by year or by type can be very revealing, 
especially if students are entering interdisciplinary data, perhaps from History, 
English and Science classes.

SPORTS  Maintain a spreadsheet of students and their best times on certain physical fitness 
events. Build in formulas for best time, worst time and average time with MAX, 
MIN, AVERAGE. For example C1 might be the fastest time in a mile run where 
each student is listed in rows 2 to 100; the formula in C1 would then be =MIN
(C2:C100).

GENERAL Have students build their own spreadsheet analyzing how much time gets spent in 
each day in classes, doing homework, sleeping, eating, etc. Build in formulas for 
percentages and averages per weekday and weekend, for example D1 might be 
=AVERAGE(D2:D100) as the average number of hours of sleep per night.

GENERAL Build a nutrition spreadsheet that lists foods and charts the characteristics of each 
food along with its percent of the total, e.g. B5 might be (B4*100)/B3 assuming 
B4 was grams of protein and B3 was total grams of the item.

LOWER What Kind of Pizza is the most popular by creating in one column
SCHOOL a list of pizza toppings and then have students tally the votes
 and then graph them with a line plot or pie chart.

LOWER  Count the M & Ms by creating in one column a list of all the
SCHOOL  colors and then in the top row a list of each packet. Students then enter the data in 

their own columns and then plot using a bar chart. Students enter at the bottom of 
each column =sum(B2:T2) and then at the end of each row a similar formula for 
both sum and average.

LOWER  Create a spreadsheet to compute batting averages and ERAs to
SCHOOL  teach a lesson in percents, decimals and fractions.
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